
FRACTON MANUAL

Getting Started 
I Don’t Read Manuals. I Want to Draw A Fractal.
Double click a Fracton file (a file with a .fracton extension) or choose menu File ->Open... . Click 
the Draw button in the lower right hand corner to draw a fractal. To cancel drawing before the 
image is completed, click the cancel button. 
See the tutorials for a detailed description of using Fracton. See the language guide for a 
description of each command of the built in fractal compiler. Continue reading this guide to see a 
description of each element of the user interface. 

Features
Fracton is a fractal creation application for the Macintosh. Fracton requires Mac OS X 10.10 or 
higher. Multiple cores are fully utilized. 
Fracton has a built in equation compiler that lets you design your own formulas in a familiar “C” 
based language. It draws fractals with image sizes of up to 16,000 x 16,000 in 24 bit color. User 
selectable anti-aliasing is used to provide nicer looking images. Import and export of Fractint 
parameter files is supported for access to tens of thousands of great fractals. Numerous drawing 
and coloring methods are supported. A variations feature simplifies searching for parameters. A 
color table editor allows creating and adjusting color palettes. Image sequence movies can be 
created by interpolating parameters. Fracton can export fractal 3D models that can be imported 
into other programs. 

Importing Parameter Files
Importing Fractint parameter files is a great way to see incredible fractals. There are literally tens 
of thousands of these files available on the internet. Most of the files have a parameter description 
and a formula but no image. Often you are rewarded with a really nice image after only a short 
wait. Fracton can import and correctly draw most of these files. A lot of effort has been expended 
to try to make Fracton work with as many parameter files as possible. 
Use the menu command File -> Import PAR... to import a Fractint parameter file. Parameter 
files must be of the correct type and have a .par file extension. The type that Fracton can read 
using Import PAR... have one parameter section at the beginning of the file and one formula 
after the parameter section. You can also copy the parameters of this type from a web page or a 
file and paste them into Fracton using the Edit -> Paste PAR... command. 
See the tutorials for a detailed description of importing parameter files. 

Parameter File Problems
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Fracton will report error messages while importing the file if it encounters commands it doesn’t 
support. Errors will sometimes occur because not all of the drawing methods and built-in 
formula types are included in Fracton.  Major errors, like an unknown built in formula type, 
probably aren’t worth drawing. A few errors are language syntax errors that can be manually 
fixed. The file is compiled when you click the Draw button. If there are syntax errors, you will 
hear a beep. Scroll down to the bottom of the formula to see a description of the errors. Nothing 
will draw until you fix all the errors and click the Draw button again. 
There are a few language differences that the PAR file translator doesn’t correct or report as an 
error. One difference is that the ^ operator is right associative in Fracton and is not in Fractint. In 
a right associative language a ^ b ^ c = a ^ (b ^ c) while in a left associative language a ^ b ^ c = (a ^ b) 
^ c. You can always fix these formulas by adding parenthesis where necessary. This is a rare 
occurrence. 
Here are a few more unusual issues that you might encounter. Right brackets inside comments 
don’t import correctly. Remove all right brackets from comments before importing. Complex 
constants must always be enclosed in parenthesis, like (1.0, 2.0). That is true in FractInt except 
inside functions the parenthesis are optional. In Fracton numbers must always be enclosed in 
their own set of parenthesis. In FractInt cos(1.0,2.0) is legal. In Fracton you must use 
cos((1.0,2.0)). 
There are also some files that draw a fractal but the image is different than an image drawn by 
Fractint. Debugging of Fracton continues and future bug fixes are planned. 

Importing Parameter Collections
Most of the time the parameter files you encounter on the web are a collection of parameters in 
one .par file and a collection of formulas in another .frm file. You can make the proper .par file 
type for Fracton by using a text editor (like the free Text Wrangler) and making a new file. To do 
that,  choose the parameter section you want copy and paste it in the new file. Next copy the 
formula that goes with it from the formula file and paste it at the end of the new file. An easier 
way is to have Fracton divide up the files for you with the File -> Divide PAR... menu. It will first 
ask for a .par parameter collection file and then ask for a .frm formula collection file. Next it will 
ask for a location to store the result files. Make sure you select a new empty folder for the files 
because there are often a few hundred different parameter descriptions in one of the collections. 
Fracton will make one .par file for each set of parameters in the source .par file. Fracton also 
makes a ~log.txt file so you can see if any of the files have errors (like not being able to find the 
formula). Errors are fairly common in the collections I have encountered on the internet. 
See the tutorials for a detailed description of importing parameter collections. 

Main Views
The upper left hand corner of the window has a segmented button with Formula, Settings, 
Color, and Image. Click the segment to change the view. 

Formula View
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1. Formula Text Field - Type an equation here. See the Language Reference for more info. 
The formula text field has full copy, paste, search, and replace capability. 

Settings View
1. Fractal Center - The real and imaginary coordinates for the center pixel of the image. It is 

easier to use arrow keys and the zoom selection box on the Image view to set the fractal 
center. 

2. Fractal Size - The real and imaginary axis size of the fractal. Larger numbers zoom out, and 
smaller numbers zoom in. You can zoom in to a size of about 1e-5000 with Formula HP or 
Mandelbrot HP. It is easier to use page up/down and the zoom selection box in the Image 
view to set the fractal size. 

3. Rotation - This number (in degrees of angle) rotates the fractal around the center pixel by 
the specified amount. Positive is counterclockwise. 

4. Skew - How many degrees the image is leaning over. Positive is counterclockwise. 
5. Parameters p1 - p5 - These complex numbers have a real and imaginary part and are just user 

defined constants that can be used in formulas. 
6. Type - The normal mode is Formula. Fracton converts imported Fractint fractal types to a 

formula. You can also select Formula HP that allows you to specify the number of digits of 
precision to use in the calculation. Formula HP is much slower than Formula and should 
only be used if you need more accuracy in the formula calculation. Additionally you can select 
Mandelbrot HP that lets you do deep zooms into the Mandelbrot set. You can zoom in to a 
size of about 1e-5000 with Formula HP or Mandelbrot HP. Selecting Mandelbrot HP 
ignores the formula and always does an equation for the Mandelbrot set using High 
Precision math. 

7. Inside - This popup menu selects the inside drawing method in parts of the image where the 
fractal never fails the bailout test. You can choose from Iteration, Index, BOF60, BOF61, 
Zmag, Epsilon Cross, Period, Fmod, and Atan. Inside index is the color table number used 
to fill the inside when Index is selected. 

8. Outside - This popup menu selects the outside drawing method in parts of the image where 
the fractal fails the bailout test (escapes). You can choose from Iteration, Index, Real, 
Imaginary, Sum, Multiply, Atan, Tdis, and Fmod. Outside index is the color table number 
used to fill the outside when Index is selected. Proximity is used in the Fmod drawing 
method. 

9. Style - This popup menu selects the drawing style. You can choose from Level Sets, 
Decomposition, Potential, or Biomorph. Decomp K is the number of divisions for the 
decomposition style. Potential Level is the maximum color number for potential. Potential 
Slope is used in the potential calculation. Biomorph Index and Biomorph Bailout are used 
in the biomorph calculation.  

10. Frames - This field sets the number of frames in a movie. 
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11. Start/End - These radio buttons allow the user to make a set of starting parameters and a 
different set of ending parameters for a movie. Clicking start shows the starting values. 
Clicking End shows the end values. All of the fields on the left side of the front panel can be 
animated. The parameters on the right side are constant during a movie. 

12. Make Equal - This button sets both the start and end left side values to the current values 
you can see on the front panel. 

13. Max Iterations - This field is the maximum number of times to iterate the formula before 
deciding it is an inside point. 

14. Periodicity - This field controls the accuracy of the periodicity calculation. Periodicity looks 
for repeating numbers and allows bailing out of inside points before iterating to the Max 
Iterations. A periodicity of 0 skips the periodicity check. 

15. Invert - Applies an evert transformation using the parameters Invert Radius, Invert Center r, 
and Invert Center i. If the Invert Radius is 0 no Invert is performed. 

16. Precision -  Starting with version 1.2 you can now do deep zooms into formulas or the 
Mandelbrot set.  Precision lets you set the number of digits of precision in the math. The 
allowable range is 19 digits to 5000 digits. 

17. Mand HP Bailout - Used for Mandelbrot HP only. Mandelbrot HP ignores the formula 
and uses this value to determine the bailout. The normal value for the bailout is 4. 

Color View
The lower left quadrant is the color strip list. The list contains all of the color strips that are a 
part of this fractal. Control(right) clicking on the list brings up a pop up menu with the following 
selections:  
1. New Color Strip = adds a grayscale color strip to the list. 
2. Import Color Strip… = displays an open file dialog where you can select a .map, .par, 

or .fracton file. The color information from that file is imported as one or more color strips. 
3. Color Strip Browser… - displays a view where a folder can be selected and used to search 

for .map or .par files. The color information of each file in the folder is displayed in a list. 
Click the “+” to add the colors to the color strip list. Click the left and right triangle to move 
to the next set of files in the folder(if any). Click done to return to the color strip list. 

4. Delete Color Strip - deletes the color strip clicked on. The color strip cannot be deleted if it 
is used in the strip sequencer. 

5. Edit Color Strip… - displays a view where the color strip can be edited. There are four 
editing methods. Click done to accept the changes or cancel to discard any changes and 
return to the color strip list. 

1. Color shows a grid tile for each color in the color strip. Click on a tile to display the Apple 
color picker and change the color. 

2. Rotate shows a view with a slider that is used to rotate the colors within the color strip. 
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3. Sine shows a view with adjustments for creating a gradient, triangle, rising quarter sine, 
falling quarter sine, half sine, and multi-sine. The adjustments can affect the red, green, or 
blue single components or all 3. A graph shows the relative intensity of each component. 
Two triangles at the bottom of the graph control the range of effect of the adjustments. 

4. Random generates a random color strip using the style in the pop up menu. Two 
triangles at the bottom of the color strip control the range of effect. 

The upper left quadrant is the strip sequencer. This view allows you to assemble many color 
strips or the same one over and over to make a composite color table for the fractal. To add a 
color strip to the strip sequencer drag and drop the strip you want from the color strip list. The 
strip will appear at the end of the strip sequencer as a short strip. Slide the handle (dot at end) of 
the strip to stretch it to the desired length. Control click on the strip to edit the range of the strip, 
duplicate the strip with the same range, or delete the strip from the strip sequencer. Drag the 
strip to another handle to change the order of the strips in the strip sequencer. One strip may 
cover several lines. The upper left hand corner of the strip sequencer represents index 0 in the 
composite color table. Assembling color strips in the strip sequencer is analogous to assembling 
movie clips in a movie editing program. 
The lower right quadrant view shows the composite color table, histogram, and mapped color 
table. The composite color table is the result of placing the strips in the strip sequencer end to 
end.  The histogram shows how many times each index of the mapped color table is used. The 
mapped color table applies the color table to the image based on a mapping method. Linear uses 
the color table repeating as necessary to cover the number of iterations in the fractal. Log and 
Simple Log only use the color table once. The first portion of the map is applied linearly and the 
second portion is applied logarithmically so that the highest index in the composite color table is 
applied to the highest iteration in the fractal. Sqrt is similar to the Log except a square root is 
used instead of a logarithm. The offset is used in Log, Simple Log, and Sqrt to ignore unused 
iterations and start the composite color table at the offset iteration. The Auto button 
automatically calculates the offset based on the first iteration used in the fractal. 
The upper right quadrant is a display of the fractal with the current colors. Changing the colors 
updates the image in real time. The image is not anti-aliased and does not change the image in 
the Image View. After color editing is complete return to the Image View and redraw the fractal 
to update the anti-aliased main image.

Debug View
1. The left part of the view displays the values of the variables in the formula. To start the trace, 

click the trace button and the values for each variable will be listed each time a variable has a 
value stored in it. 

2. Start Line  - Start the trace at this line. 
3. Number Lines - The number of lines in the trace 
4. Trace button - Click the trace button to start the trace. 

Image View
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1. The left part of the view is the fractal image. Use keyboard commands to move around and 
zoom the image. A zoom selection box will appear when keyboard commands are used. 

2. Left arrow, right arrow, up arrow, down arrow keys - Use these to move the zoom selection 
box. Holding option increases the movement amount. 

3. Page up, page down keys - These keys make the zoom selection box larger or smaller 
respectively. Holding option increases the size change. 

4. Click and drag in the image to quickly make a zoom selection box. Then, adjust the location 
and size of the box with keyboard commands. 

5. Return, enter keys - Redraw the fractal. Just like pressing the Draw button. 
6. Image size - This area has a popup menu with commonly used presets and two fields that 

allow the user to enter a custom size for the fractal drawing window. The image size can be 
up to 16000 pixels. Larger images take longer to draw. 

7. Anti-aliasing - This popup lets you set the amount of anti-aliasing applied to the image. 
None or 1 x 1 has no anti-aliasing but is the fastest. You can select up to 5 x 5 for a much 
smoother image. The 5 x 5 anti-aliasing takes 25 times as long to draw. For most images 2 x 2 
is a good compromise between a good looking image and speed. 

8. Elapsed time - While drawing, an elapsed time and a remaining time text field shows how 
long it will take to draw the fractal. 

9. Draw - The draw button compiles the formula, collects the data from the user interface, and 
draws the image. If you hear a beep, that means there are compile errors. Go to the Formula 
view by clicking Formula at the top left of the window. Scroll down to the bottom of the 
formula text field to see the errors. Correct the formula errors and go back to the Image 
View and click draw again. Nothing will draw until the formula compiles successfully. You 
can tell you are drawing an image because a blue stripe will appear from the top to bottom 
on the left side of the Image view. Also the elapsed time text field in the lower left will show 
the elapsed time or calculating time remaining. In addition, a progress bar will appear in the 
lower right corner. Some fractals draw in less than one second and some can take a long time 
to appear in the display. The difference in time is mainly caused by how many iterations it 
takes before the fractal completes the bailout test. 

10. Cancel - Cancels drawing. 

Preferences Window
Set the number of cores to use for fractal calculation. Using more cores make fractals draw faster 
but make the computer more sluggish when updating the screen or running other programs 
simultaneously. Recommended values are cores - 1 for non-hyperthreaded CPUs and cores / 2 for 
hyper threaded CPUs. Hyperthreaded CPUs report twice as many cores as they actually have so 
that is the reason for suggesting half of the reported amount. 

File Menu Commands
1. New - Resets Fracton to a classic Julia fractal. 
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2. Open, Open Recent, Close, Save, Save As, and Revert - Do just what you expect, except you 
are not warned to save a file after making changes. It’s on the to do list. 

3. Import PAR... - See Importing Parameter Files. 
4. Divide PAR... - See Importing Parameter Collections. 
5. Export Image... - Saves the fractal image as a TIFF file. Currently, you are not prevented 

from saving the file before it has finished drawing. Another thing to fix. 
6. Export Model... - Exports  3D height field OBJ files that can be imported into other 

programs. See Export Model section below for more details. 
7. Export Movie... - Exports a TIFF image sequence with one image for each frame requested 

in the Frames field. The elapsed time text field and progress bar in the lower left corner give 
an estimate of the time to complete the movie. Movies can take a long time to complete. The 
cancel button can be used to stop an Export Movie.... 

8. Page Setup... and Print... - These print whatever field is targeted with the cursor. It is only 
really useful to print the formula text field. The fractal window does not print. To print a 
fractal image, export the image using Export Image... and open and print the file with any 
image editing program. You can use the free program Preview that comes with every 
Macintosh. 

Edit Menu Commands
1. Undo and Redo - Sadly, there is no undo or redo yet. Again, on the list. 
2. Cut, Copy, Paste, Delete, Select All - These commands do just what you think when 

targeted in the formula text field or a number field. 
3. Paste PAR... - See Importing Parameter Files. 
4. Find... - Opens a find dialog that can be used to search, find, and replace text in the formula 

text field. Very useful. 
5. Spelling... and Special Characters... - Not sure. Never used them. Probably, should be 

removed. 

Help Commands
1. Fracton Help - A HTML version of this manual will be accessible from help but it’s not 

available yet. 

Export Model
Fracton can export a 3D height field model of  a fractal that can be imported into other 
programs. The export model dialog can be accessed with the menu command File -> Export 
Model.... 
Grid Samples controls the resolution of the grid that is used to search for all the edges in the 
model.  The numbers must be a multiple of 10. Larger numbers mean more samples and a higher 
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quality model but at the cost of increased time and file size. Typical numbers for acceptable 
quality in simple models is 200 to 400. 
Model Size controls the scaling for the model. Cheetah 3D and some other programs auto scale 
these numbers so the default numbers are fine. 
Min Ext Angle sets the minimum external angle (in degrees) of the angles along the edges of the 
model. Fracton tries to insert more points along the edges until this condition is met or the 
distance between the two points is less than the Min Edge Length. Likewise, it deletes points 
that have angles smaller than the minimum. Smaller numbers make more accurate models at the 
expense of increased time and file size. The default value of 10 degrees is usually good. 
Min Edge Length sets the minimum distance (in grid units) between points along the edges as 
mentioned in the Min Edge Angle paragraph. Smaller numbers make more accurate models at 
the expense of increased time and file size. The default value of 0.1 grid units is usually good.  It is 
usually best to adjust the Grid Sample size to control the model quality. 
Min Face Area sets the minimum area size (in square grid units) of polygons in the model. Any 
polygon smaller than this number gets discarded. Models with lots of tiny features will take a 
very long time if this number is too small. Suggested values for this parameter are 1 to 4 at 100 x 
100 grid samples. Since this parameter is an area it should increase by the square of the grid 
samples. For example if you used the value of 1 at 100 x 100 grid samples you should use a value 
of 4 at 200 x 200 grid samples to discard the same size features. 
Upper and Lower Clamp allow you to limit the model to a vertical portion of the fractal. This is 
very important in fractals that have a lot of iterations that would be too slow and too complex to 
make otherwise. After you export the model for the first time Fracton will change these numbers 
to the actual numbers it found in the fractal if they are more restrictive than the numbers you have 
entered here. Exiting the export model dialog resets this field to the initial values. 
Texture Vert lets you select whether or not you want to have the colors from the 2D fractal 
included with the exported model. Selecting Color Index includes the texture vertices in the 
model and exports a small color texture file that you use in the 3D program.  Selecting none 
leaves these out. 

Credits
Fracton is freeware. Programming by Michael Frazier, ©2010-2015. All rights reserved. See the 
Fracton website at http://www.fracton.org/ Fracton Seahorse by Michelle Spalding, ©2010. 
Fracton is not affiliated with Fractint. Fractint copyright is by the Stone Soup Group. See http://
www.nahee.com/spanky/www/fractint/intro.html 
Fracton is not affiliated with Cheetah 3D. Cheetah 3D is copyright 2001-2014 MW3D-
Solutions. See http://www.cheetah3d.com/ for more information. 
Special thanks to Jim Muth and the Fractint community for all those great fractals.
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